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Introduction
This is a free supplementary document available from the Dolphin Learning Zone. It is part of the Microsoft Outlook 365 Classic Desktop Edition with SuperNova and Dolphin ScreenReader support pages.
This document contains the keyboard commands you use to complete many popular tasks in Outlook 365, alongside the SuperNova and Dolphin ScreenReader hotkeys that may assist.

Enhance Outlook with sounds
You can enhance your experience using Outlook by enabling sounds. When enabled, sounds will reinforce many of the common actions you perform such as deleting, cutting, pasting, and actions like autocorrection, opening task pane, and closing task pane.
When enabled, the sound effects are used in all Microsoft Office apps irrespective of the app you chose to turn them on.
To enable sounds:
1. Open Excel, Outlook, PowerPoint, or Word.
2. Open the "File" menu and select "Options" (ALT + F, T).
3. Select the "Accessibility" category.
4. Select "Provide feedback with sound" check box (ALT + S).
5. TAB to and select a sound scheme. You can choose between two different sound schemes: Modern and Classic.
6. Select the "OK" button.

Hotkey conflicts
You may experience a hotkey conflict with some of the stated keyboard commands. If you are unfamiliar with resolving hotkey conflicts, please visit Resolving hotkey conflicts with Apps.
	Command
	Desktop NumPad Set 
	Laptop Universal Set

	Pass next key to application
	LEFT CONTROL + 7
	CAPS LOCK + 3

	Toggle hotkeys on off
	LEFT CONTROL + 8
	LEFT SHIFT + CAPS LOCK + 3



Navigating UI elements including Ribbon, Task Pane, and Status Bar
	Command
	Hotkey

	Move focus to next main element
	F6

	Move focus to previous main element
	SHIFT + F6

	Move focus to the Ribbon tab
	ALT or F10

	Move focus to a specific Ribbon tab
	ALT + Ribbon tab key (for example ALT + H to move to the Home tab, ALT + N to move to the Insert tab, etc.

	Open the context menu
	SHIFT + F10 or APPLICATION KEY

	Move focus to the previous group in the Ribbon
	CONTROL + LEFT ARROW

	Move focus to the next group in the ribbon
	CONTROL + RIGHT ARROW

	Explore commands
	Arrow Keys or TAB / SHIFT + TAB

	Close Task Pane
	Press F6 to move focus to the Task Pane, then CONTROL + SPACEBAR to open the task pane menu, and select "Close"
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	Command
	Desktop NumPad Set 
	Laptop Universal Set

	Speak focus
	NUMPAD 0
	CAPS LOCK + UP ARROW

	Speak additional focus information, describes help text and shortcut key for current Ribbon command
	LEFT SHIFT + NUMPAD 0
	LEFT CONTROL + CAPS LOCK + UP ARROW

	Speak shortcut key
	LEFT SHIFT + NUMPAD PERIOD
	LEFT CONTROL + CAPS LOCK + LEFT ARROW

	Speak status bar information
	NUMPAD 2
	CAPS LOCK + PAGE DOWN

	List commands in the Quick Access Toolbar
	CAPS LOCK + Q
	CAPS LOCK + Q


[bookmark: _Hlk141438045]---
Tip: The shortcut key for a Ribbon tab, and the descriptive text for Ribbon commands, are automatically announced when using a High Verbosity Scheme. You can adjust your Speech Verbosity Scheme by pressing CAPS LOCK + EQUALS or, if you are using the Laptop Universal hotkey set, press CAPS LOCK + V.
To change your Braille Verbosity Scheme, press LEFT SHIFT + CAPS LOCK + EQUALS OR, if you are using the Laptop universal Hotkey Set, press LEFT CONTROL + CAPS LOCK + V.
---

Go to, open, create, search, and close commands in Outlook
	Command
	Hotkey

	Go to Inbox
	CONTROL + SHIFT + I

	Go to Outbox
	CONTROL + SHIFT + O

	Go to Mail folder
	CONTROL + 1

	Go to Calendar folder
	CONTROL + 2

	Go to Contacts folder
	CONTROL + 3

	Go to Tasks folder
	CONTROL + 4

	Open "Go to folder" dialog box
	CONTROL + Y

	Go back to previous visited folder
	ALT + LEFT ARROW

	Go forward to next visited folder
	ALT + RIGHT ARROW

	Create a new item based on current Outlook folder type
	CONTROL + N

	Create a new mail message from any folder in Outlook
	CONTROL + SHIFT + M

	Create a new appointment from any folder in Outlook
	CONTROL + SHIFT + A

	Create a new meeting from any folder in Outlook
	CONTROL + SHIFT + Q

	Create a new task from any folder in Outlook
	CONTROL + SHIFT + K

	Create a new task request from any folder in Outlook
	CONTROL + SHIFT + ALT + U

	Create a new note from any folder in Outlook
	CONTROL + SHIFT + N

	Create a new contact from any folder in Outlook
	CONTROL + SHIFT + C

	Create a new contact group from any folder in Outlook
	CONTROL + SHIFT + L

	Save changes to the current item
	CONTROL + S

	Post current item
	ALT + S

	Open "Address Book" dialog box
	CONTROL + SHIFT + B

	Open the "Save As" dialog box
	F12

	Open the "Print" options 
	CONTROL + P

	Search in Outlook
	ALT + Q

	Search in current folder
	CONTROL + ALT + K

	Search in current folder and subfolders
	CONTROL + ALT + Z

	Search in all folders
	CONTROL + ALT + A

	Open "Advanced Search" DIALOG BOX
	CONTROL + SHIFT + F

	Close Outlook
	ALT + F4



Working with mail
The following table provides Outlook hotkeys for navigating mail folders and opening messages. The hotkeys presume you are using the default mail folder view. If you have customised your view, then certain hotkeys may not be applicable.
	Command
	Hotkey

	Navigate messages in mail folder
	UP ARROW and DOWN ARROW

	Navigate messages in mail folder including group headings
	ALT + UP ARROW and ALT + DOWN ARROW

	Collapse and expand group headings in mail folder
	Move focus to group heading and press ENTER

	Mark message as read in mail folder
	CONTROL + Q

	Mark message as unread in mail folder
	CONTROL + U

	Set follow-up flag for message in mail folder
	CONTROL + SHIFT + G

	Mark the message as not junk in mail folder
	CONTROL + ALT + J

	Open a mail message
	ENTER or CONTROL + O

	Open next message when viewing a current message
	CONTROL + COMMA

	Open previous message when viewing a current message
	CONTROL + Full Stop

	Delete currently opened message
	CONTROL + D

	Forward message
	CONTROL + F

	Forward message as an attachment
	CONTROL + ALT + F

	Reply to sender
	CONTROL + R

	Reply to all recipients of the mail message
	CONTROL + SHIFT + R or ALT + L



Useful SuperNova and Dolphin ScreenReader commands when reading received messages
	Command
	Desktop NumPad Set 
	Laptop Universal Set

	Speak message header including recipients and notifications
	CAPS LOCK + H
	CAPS LOCK + H

	Speak date from message header
	CAPS LOCK + D
	CAPS LOCK + D

	Move Dolphin Cursor to notification area
	NUMPAD SLASH (repeat until area reached)
	LEFT CONTROL + CAPS LOCK + Z (repeat until area reached)

	Simulate Left Click with Dolphin Cursor
	INSERT
	CAPS LOCK + 8

	Simulate Right Click with Dolphin Cursor
	DELETE
	CAPS LOCK + 9

	Activate links in the body of a message using the Dolphin Cursor
	ENTER
	ENTER

	Read mail message using Read from here
	NUMPAD PLUS
	CAPS LOCK + DOWN ARROW

	When using Read from here, pause / restart reading
	SPACEBAR
	SPACEBAR

	Exit Read from here
	ESCAPE
	ESCAPE


---
Tip: Outlook defaults to opening links in Microsoft Edge. If you prefer to open links in your default browser, go to "Outlook Options" (ALT + F, T), select the "Advanced" category, and set "Open hyperlinks from Outlook in" setting to "Default browser".
---

Navigating and selecting text commands
	Command
	Hotkey

	Move focus to previous / next character
	LEFT / RIGHT ARROW

	Move focus to previous / next word
	CONTROL + LEFT / RIGHT ARROW

	Move focus to previous / next line
	UP / DOWN ARROW

	Move focus to previous / next paragraph
	CONTROL + UP / DOWN ARROW

	Move focus to start of line
	HOME

	Move focus to end of line
	END

	Select a character
	Position the focus to the left of the character and press SHIFT + RIGHT ARROW

	Select a word
	Position the focus to the left of the word and press CONTROL + RIGHT ARROW

	Select a line
	Position the focus at the start of the line and press SHIFT + DOWN ARROW

	Select a paragraph
	Position the focus at the start of the paragraph and press SHIFT + CONTROL + DOWN ARROW

	Select all
	CONTROL + A

	Enable Selection Mode
	F8

	Extend selection when using Selection Mode
	Arrow Keys

	Extend unit selection such as word, sentence, and paragraph when using Selection Mode
	F8 multiple times

	Cancel Selection Mode
	ESCAPE



Working with text when composing messages
Outlook includes a wealth of keyboard commands that make working with text a productive experience when using the keyboard. In most cases, the stated hotkeys require you to select prior to applying the hotkey.
	Command
	Hotkey

	Change the case of text
	SHIFT + F3. Repeated presses of this hot key will cycle through the separate ways the capital letter style can be applied including uppercase, lowercase, and initial case

	Capitalise all letters
	CONTROL + SHIFT + A

	Insert an optional hyphen
	CONTROL + MINUS

	Insert a non-break hyphen
	CONTROL + SHIFT + MINUS

	Insert a non-break space 
	CONTROL + SHIFT + SPACEBAR

	Insert the current date
	SHIFT + ALT + D

	Insert the current time
	SHIFT + ALT + T

	Insert the copyright symbol
	CONTROL + ALT + C

	Insert the REGISTRATION symbol
	CONTROL + ALT + R

	Insert the trademark symbol
	CONTROL + ALT + t

	Insert a blank equation
	ALT + EQUALS

	Copy text
	CONTROL + C

	Cut text
	CONTROL + X

	Paste text
	CONTROL + V

	Copy text formatting
	CONTROL + SHIFT + C

	Paste text formatting
	CONTROL + SHIFT + V

	Undo
	CONTROL + Z

	Redo
	CONTROL + Y



Formatting text and paragraphs when composing messages
Outlook includes keyboard commands that enable you to change the formatting of text quickly and easily from the keyboard.
	Command
	Hotkey

	Make text bold
	CONTROL + B

	Make text italic
	CONTROL + I

	Make text underlined
	CONTROL + U

	Make Text subscript
	CONTROL + EQUALS

	Make text superscript
	CONTROL + SHIFT + EQUALS

	Left align a paragraph
	CONTROL + L

	Centre a paragraph
	CONTROL + E

	Justify a paragraph
	CONTROL + J

	Right align a paragraph
	Control + r

	Single line space a paragraph
	CONTROL + 1

	One-and-a-half-line space a paragraph
	CONTROL + 5

	Double line space a paragraph
	CONTROL + 2

	Full Left align indentation
	CONTROL + M

	Hanging indentation
	CONTROL + T

	Reset paragraph style back to default values
	CONTROL + Q

	Reset character style back to default values
	CONTROL + SPACEBAR
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	Command
	Desktop NumPad Set 
	Laptop Universal Set

	Cycle typing modes
	CAPS LOCK + SEMI COLON
	CAPS LOCK + 2

	Speak character
	NUMPAD 4
	CAPS LOCK + LEFT ARROW

	Speak word
	NUMPAD 5
	CAPS LOCK + RIGHT ARROW

	Speak line
	Numpad 6
	CAPS LOCK + UP ARROW

	Speak line to focus
	Left shift + numpad 1
	CAPS LOCK + HOME

	Speak line from focus
	LEFT SHIFT + NUMPAD 2
	CAPS LOCK + END

	Speak sentence
	CAPS LOCK + NUMPAD 4
	LEFT CONTROL + LEFT SHIFT + CAPS LOCK + S

	Speak paragraph
	CAPS LOCK + NUMPAD 5
	LEFT CONTROL + LEFT SHIFT + CAPS LOCK + P

	Speak selection
	NUMPAD 1
	LEFT SHIFT + CAPS LOCK + DOWN ARROW

	Read message using Read from here
	NUMPAD PLUS
	CAPS LOCK + DOWN ARROW

	When using Read from here, pause / restart reading
	SPACEBAR
	SPACEBAR

	Exit Read from here
	ESCAPE
	ESCAPE



---
Tip: Speak keys provide additional output when pressed multiple times, for example, pressing the Speak character hotkey twice means the character is spelt phonetically, a third press describes the character’s font attributes, and a fourth press states the character’s Unicode value.
---

Useful SuperNova and Dolphin ScreenReader commands for reviewing text formats
	Command
	Desktop NumPad Set 
	Laptop Universal Set

	Speak character attributes
	NUMPAD 4 (on third press)
	CAPS LOCK + LEFT ARROW (on third press)

	Speak additional focus information about paragraph formatting
	LEFT SHIFT + NUMPAD 0
	LEFT CONTROL + CAPS LOCK + UP ARROW



---
Tip: You can automate the announcement of style changes through the "Text Style Announcements" dialog box in the SuperNova and Dolphin ScreenReader Control Panel. You may find this useful when proof-reading a message for formatting changes.
---

Applying popular inbuilt styles when composing messages
Outlook includes keyboard commands that enable you to quickly apply its own inbuilt styles to paragraphs. The use of Styles ensures your message has a consistent look and feel when being viewed.
	Command
	Hotkey

	Apply Heading 1 Style to the current paragraph
	CONTROL + ALT + 1

	Apply Heading 2 Style to the current paragraph
	CONTROL + ALT + 2

	Apply Heading 3 Style to the current paragraph
	CONTROL + ALT + 3

	Apply Normal Style to the current paragraph
	CONTROL + SHIFT + N

	Apply List Bullet Style to the current paragraph
	CONTROL + SHIFT + L



Adjusting lists and tables when composing email messages
You can reorder, promote, and demote the order of the bullet and numbered items in a list without the necessity to cut and paste using keyboard commands. You can also use the same keyboard commands to adjust the position of rows in tables.
	Command
	Hotkey

	Move list item or table row up
	SHIFT + ALT + UP ARROW

	Move list item or table row down
	SHIFT + ALT + DOWN ARROW

	Promote list item
	SHIFT + ALT + LEFT ARROW

	Demote list item
	SHIFT + ALT + RIGHT ARROW



Working with tables when composing email messages
As mentioned in the previous section, you can re-order rows in a table by pressing SHIFT + ALT + UP / DOWN ARROW. The following keyboard commands can also be used in tables.
	Command
	Hotkey

	Navigate cell content
	Arrow Keys

	Select content in next cell
	TAB

	Select content in previous cell
	SHIFT + TAB

	Go to first cell in column
	ALT + page up

	Go to last cell in a column
	ALT + PAGE DOWN

	Go to first cell in row
	ALT + HOME

	Go to last cell in row
	ALT + END

	Select entire row
	Position focus at start of row and press SHIFT + ALT + END

	Select entire column
	Position focus at start of column and press SHIFT + ALT + PAGE DOWN

	Delete all content in a table
	Select table and press DELETE

	Delete table
	Select table and press BACKSPACE
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SuperNova and Dolphin ScreenReader includes useful Speak keys you can use when creating tables in messages.
	Command
	Desktop NUMPAD Hotkey Set
	Laptop Universal Hotkey Set

	Speak row and column co-ordinates
	NUMPAD 3
	SHIFT + CAPS LOCK + LEFT ARROW

	Speak column
	CAPS LOCK + NUMPAD 6
	SHIFT + CAPS LOCK + RIGHT ARROW

	Speak column from current cell
	CAPS LOCK + NUMPAD PERIOD
	SHIFT + CAPS LOCK + PAGE DOWN

	Speak column to current cell
	CAPS LOCK + NUMPAD 3
	SHIFT + CAPS LOCK + PAGE UP

	Speak row
	CAPS LOCK + NUMPAD 0
	SHIFT + CAPS LOCK + UP ARROW

	Speak row from current cell
	CAPS LOCK + NUMPAD 2
	SHIFT + CAPS LOCK + END

	Speak row to current cell
	CAPS LOCK + NUMPAD 1
	SHIFT + CAPS LOCK + HOME




Working using Calendar View
	Command
	Hotkey

	Go to next event
	TAB

	Go to previous event
	SHIFT + TAB

	Open an event
	ENTER or CONTROL + O

	Display Day View
	CONTROL + ALT + 1

	Display Work Week View
	CONTROL + ALT + 2

	Display Week View
	CONTROL + ALT + 3

	Display Month View
	CONTROL + ALT + 4

	Display Schedule View
	CONTROL + ALT + 5

	Go to today
	CONTROL + T

	Go to next day
	RIGHT ARROW

	Go to previous day
	LEFT ARROW

	Open "Go to date" dialog box
	CONTROL + G

	Navigate time slots when using Day View and Week Views
	UP ARROW and DOWN ARROW

	Go to start of day when using Day View and Week Views
	CONTROL + HOME

	Go to end of day when using Day View and Week Views
	CONTROL + END

	Go to start of working day when using Day View and Week Views
	HOME

	Go to end of working day when using Day View and Week Views
	END

	Go to previous week when using Day View and Week Views
	ALT + UP ARROW

	Go to next week when using Day View and Week Views
	ALT + DOWN ARROW

	Go to start of week when using Day View and Week Views
	ALT + HOME

	Go to end of week when using Day View and Week Views
	ALT + END

	Go to previous week when using Month View
	[bookmark: _Hlk146201127]UP ARROW

	Go to next week when using Month View
	DOWN ARROW

	Go to previous month
	ALT + PAGE UP

	Go to next month
	ALT + PAGE DOWN




Other useful SuperNova, Dolphin ScreenReader, and Outlook keyboard commands
Here is a list of assorted commands you may find helpful when working in Outlook.
	Command
	Hotkey

	Spell check a message
	F7

	Move to next spelling error in message and open context menu
	ALT + F7

	Look up current word in Thesaurus
	SHIFT + F7

	Open the "Find" option
	CONTROL + F or F4

	Continue search within the message body
	SHIFT + F4

	Open the "Replace" option
	CONTROL + H

	Open the "Go to" option
	CONTROL + G or F5

	Open SuperNova and Dolphin ScreenReader Item Finder to view a list of links, headings, tables, etc. in a message
	CAPS LOCK + TAB

	Move focus to Outlook Popup Notification (balloon) window
	SHIFT + WINDOWS KEY + V

	Open SuperNova and Dolphin ScreenReader Notification Finder to view a list of Windows Popup Notifications
	CAPS LOCK + SPACEBAR, F3 (or CAPS LOCK + SPACEBAR, Y, N)
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